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iManége DeskSite User Reference Manual

Note: To compare versions of the same document you must show all versions of
the document. See “Defaults Tab” on page 153 for details.

2. Select Applications from the Document menu.

3. Select CompareRite or DocuComp from the submenu that appears. The
CompareRite or DocuComp dialog box appears. The version of the docu-
ment shown first in the document grid is listed as the original document. You
can sort the grid by version number by clicking the column heading.

QiE: “DOCUME ™1 \bowem\LOCALS 1\ Temp\Result of compar

Figure 6.1: CompareRite dialog box

4. The application saves the comparison results to the file named in the Com-
pare Doc Name field. Enter a filename in this field.

5. Select how you want to handle the resulting comparison document.

—  Select the Open button to the results document.

—  Select the View button to view the comparison results with the IManage
View program.

—  Select the Import button to import the comparison results document
automatically into iManage DeskSite.
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6. Click Compare to perform the comparison.
Using FullAuthority or CiteRite

FullAuthority and CiteRite are software applications provided by Lexis-Nexis
that enable you to analyze the citations in a document. For the Full Authority and
CiteRite menu options in iManage DeskSite to work properly, these applications
must be integrated correctly with iManage DeskSite.

To analyze citations in a document using FullAuthority or CiteRite:
1. Highlight a document in the document grid.
2. Select Applications from the Document menu.

3. Select FullAuthority or CiteRite from the submernu that appears. The Full-
Authority or CiteRite dialog box appears with the highlighted document
listed in the dialog box.

4. In the Output Doc Name field, enter a filename that will be used to store the
table of authorities or citation report that will be produced by FullAuthority :—
or CiteRite.

—  Select the Open radio button to open the ountput file automatically.

—  Select the View radio button to view the output file in the iManage
Viewer

—  Select Import to add the output file to an iManage library.

5. Click Run to ran FullAuthority or CiteRite analysis on the selected docu-
ment.
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Figure 6.2: FullAuthority dial.og box
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Configuration Options

iManage DeskSite allows you to customize the way information is displayed. To
access the Display Options dialog, select Options from the Options menu. The
Configure dialog is displayed in three tabs, Select Profile Fields, Defaults, and
Configure.

Select Profile Fields Tab

The Select Profile Fields tab allows you to customize which profile fields dis-
play in the Document Grid and the Document Profile tab in the Document
Results Frame.
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Figure 6.3: Configure dialog, Select Profile Fields tab

To customize the Document Grid

The Display Column Fields list contains those fields that are already selected to
be included in the Document Grid (upper right side of the iManage DeskSite
Desktop}. The column fields appear in the Document Grid in the same order in'
which they appear in this list.

1. To add profile fields to this list, select the desired field(s) from the Available
Profile Fields list and click Add.

2. Toremove aprofile field from the Document Grid, select the fields in the
Display Column Fields list and click Remove.
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3. Drag and drop the selected fields into the desired order.

To Customize the Document Profiles tab of the Document Resulis Frame

The Profile Fields list contains those fields that appear in the Document Profiles
tab of the Document Results frame in the lower-right side of iManage DeskSite
Desktop. These fields appear in the same order in which they appear in the list.

1. To add profile fields to the Profile Fields list, select the desired field(s) from
the Available Profile Fields list and click Add.

2. To remove profile fields from the profile list, select the fields in the Display
Column Fields list and click Remove,

3. Drag and drop the selected fields into the desired order.
Defaults Tab

A number of different system settings are completed in the Default tab of the
Display Options dialog.
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Figure 6.4: Configure dialog, Defaults tab

Options of the Defaults tab:

+  Inthe Maximum Number of Docnments in Search Window field, enter
the maximum number of documents that should appear in the Document
Grid as the result of a search. The default value is 500.

»  In the Document Version box, select either All Versions or Latest Version
Only.

Note: If you select Latest Version Only, you can still locate all the versions of a
document in the library by highlighting the document in the grid, then clicking
the Document Versions tab.
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Tn the Change Portable Options box, you can change the drive designation
of your Portable directory. The Portable Path is hard-coded to NRPORTBL.

n the Change Echo Options box, you can change the drive designation of
your echo directory and the size, in megabytes, of the Echo Directory. The
Echo path is hard-coded to NRTECHO. You can also change the size of your
Echo Directory by clicking the up or down arrows next to the Echo Size

(MB) field.

In the WorkSite box, you can enter the URL for accessing imanage Work-
Site in the Base Path field. iManage DeskSite uses this information when
you enter the commands Send Document URL Link or Send Folder URL
Link from Send on the Document menu.
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Configure Tab

# Document Options
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D Check for checked-out documents on startup/esit.
.-’-'-.du:l imphcit wildeard characters to description searches.
D Delete local files after import.
Fiter COMPARE and OCR classes out.
Check for modified echo documents on stafupesit.
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o

Figure 6.5: Advanced Options dialog, Defaults tab = -

Timeout Option ) [
Use the Timeout option to determine how long the iManage DeskSite client |
waits before timing out. The default value is 30. You may need to increase this

value when connection times are slow or when downloading large files, for
example, over a WAN connection.
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Document Options

‘When Use Forms and Captions from preferred database is checked, the |
iManage DeskSite client downloads the Forms and Captions stored on the
user’s Preferred Database as you need them and applies these forms and cap-
tions to other databases. When this option is not checked, Forms and Cap- |
tions are downloaded from each individual database as you need them.

When Check for Checked Out Documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately after login
whenever it detects altered checked out portable documents on your hard
drive.

When Add implicit wildeard characters to description searches is
checked, iManage automatically inserts an asterisk at the beginning and end
of the search string in the description field when performing a profile search.

When Delete local files after import is checked, iManage removes docu-
ments from your local drive after you import them to iManage DeskSite.

When Filter COMPARE and OCR classes out is checked, iManage
DeskSite excludes all documents with the COMPARE and OCR (optical
character recognition) document classes. If you want to include documents
created with document comparison or OCR software, make sure this box is
not checked.

When Check for modified echo documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately after login
whenever it detects altered echo documents on your hard drive.

When Check for orphaned documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately afier login
whenever it detects orphaned documents on your hard drive. See “Orphan
Documents” on page 195 for more information about orphaned documents.

Other Options

When Verify before exiting iManage DeskSite is checked, you get a mes-
sage asking if you are sure you want to close iManage when you click the
exit button or select Exit from the File menu.

When Check for Microsoft Word before exiting iManage DeskSite is
checked, iManage DeskSite determines if the Microsoft Word application is
open. If so, you receive a warning message asking if you want to close iMan-
age DeskSite even though Word is still running.

When Choose connection mode when starting is checked, you have the
option of connecting to the server, working in Portable mode, or logging in
manually.
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erver Connection

Figure 6.6: Server Connection dialog

— Ifyou choose Connect, iManage DeskSite opens and connects to the
servers that are registered and selected for auto login.

— Ifyou choose Portable, iManage Portable opens.

—  Ifyou choose Manual Login, the Register Servers dialog opens so you
can log into the servers you choose. See “Connecting to WorkSite Mid-
dle Tier Servers” on page 44.

+  When Always sort worklist by my access time is checked, the work list on
the document grid sorts in the order in which the current user accessed the
documents. This order may differ from the actual edit time of some docu-
ments since the edit time of a document changes if another user accesses the
file.

*  When Show Worklist separately for each database is checked, the tree
frame shows both a consolidated worklist that includes all databases and an
individual worklist for each database that shows the documents that you
worked on most recently from just that database.

*  When Show overflow message if search returns have more entries is
checked, you receive an indicator in the status bar showing that your search
request received more matches than in the search results list.

Figure 6.7: Overflow indicator

Purge temp documents if older than __ Days

‘When you perform Print, View and Quick View operations in iManage DeskSite,
the system creates temporary files on your computer. This setting lets vou deter-
mine how long to retain these files. When you close iManage DeskSite, these
files are permanently deleted after the number of days you specify here.
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Default Command

Select from the list of commands in the Default Command drop-down menu to

decide what a double-click should signify in the Document Grid. See the table
below for details. Click OK when you have finished setting defaults.

Open iManage DeskSite opens the document in its associated
application.

Edit Profile You can view or edit profile information for the document.

Print iManage DeskSite prints the document.

Quickview The document appears in the Quickview frame.

View iManage DeskSite opens the document in the View appli-

' cation.

Versions The document version tab displays a list of all the versions
of the document.

History Document activity history for the document is displayed

Related The related document tab displays a list of all the docu-

Documents ment related to the selected document.

Checkout The Checkout dialog box appears with the document listed

' as the document to be checked out.

Checkin The Checkin dialog box appears with the document listed
as the document to be checked in.

Checkedout iManage DeskSite opens the Checkedout Info message

Info box.

Export iManage DeskSite opens the Export dialog box.

Unlock ‘| iManage DeskSite unlocks the document.

Remove from iManage DeskSite removes the document from. the current

Folder folder. The document is still in the library.

Purge iManage DeskSite deletes the document from the Jibrary.
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Overview

iManage View lets you view documents without the need to launch their native
applications. You can view multiple documents and print all or porticns of the
documents being viewed. 7

To view documents from the iManage DeskSite program, select one or more doc-
uments you want to view in the document grid, then select View from the Docu-
ment meou. A submenu appears; select View again from the submenu. If
iManage View is not running, iManage DeskSite launches iManage View, then
displays the documenits in read-only format. You can also display documents in
iManage View by highlighting multiple documents, then clicking on the View
button in the toolbar.

To view documents from the iManage Integrated Desktop, select documents in
the documents list and right-mouse-click. Then choose View from the pop-up
menu. The iManage View program will launch with the documents displayed in a
view window.

You can also launch the iManage View application manually.
iManage View allows you to;

+  View documents in read-only format even when they are checked out orin
use.

»  Search the full text of documents currently displayed in the viewer.
+  Copy porticns of documents for pasting into other applications
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*  Print documents

File types supported by iManage View include all major word-processing,
spreadsheet, and graphics file formats.

Note: When you view documents using iManage View, those documents are not
locked or checked out of the database. Instead, the iManage View program makes
a temporary copy of the document, which is displayed in read-only format.

Document Types Supported

The major word processing, spreadsheet, and graphic formats supported by
iManage View are listed below:

Word Processing Formats

Word for Windows 1.0, 2.0, 6.0/7.0 and 2000
WordPerfect for Windows or DOS 5.0, 5.1/5.2, 6.0 and 7.0
AmiPro 3.0 ‘

‘Word Pro

Windows Write

Word for DOS 5.x and 6.0

Professional Write 2.0

DisplayWrite

MultiMate

OfficeWriter

Wang PC ‘

FrameMaker Interchange Format (MIF) (text only)
StarQffice Writer 5.2 (text only)

ANSI Text

Spreadsheet Formats

le4

Excel 3.0,4.0,50and 7.0
Lotus 1-2-3 for Windows or DOS 3.x and 4.x
QuattroPro for Windows
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Graphic Formats
Windows Bitmap
Windows Metafile
WordPerfect Graphic 1.0, 2.0
Ami Draw
Tagged Image File Format TIFF
Micrografx DRW
CompuServe GIF
Paintbrosh PCX

Miscellaneous Formats
Adobe Acrobat PDF (text only)
Website META Language (WML)

Presentation Formaits 7

Microsoft PowerPoint
iManage View Window

If you launch iManage View manually, the iManage View window initially con-
tains no documents. If launched automatically—such as when you select the
View option in iManage DeskSite—this window contains read-only copies of the
documents that vou selected. Below is an example of the iManage View window
with three local documents displayed in tile format.
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Figure 7.1: iManage View with documents displayed in cascade format

Tile and Cascade Formats

You can display documents in cascade or tiled format. Figure 7.1 shows an exam-
ple of the filed format. Following is an example of the same iManage View win-

dow with the three documents displayed in cascade format. You can also display

other documents in the window as minimized icons.
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Figure 7.2: iManage View with documents displayed in cascade format

Viewing Local Files

You can use the iManage View program to view documents on an iManage data-
base and/or documents that are stored locally on your hard drive or another net-
work drive.

To view local documents:

1. Launch the iManage View program.

2. Select Local Open from the File menu. The Select Local File to View dia-
log box opens. ‘ '
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Figure 7.3: Select Local File to View dialog box

Import by

Eﬂj Integrated

Localhpp:

3. Use standard Windows techniques to locate and select a local file to view in
the iManage View program, then click Open to display the file in the view

program.

Searching the Full Text of Documents

168

nowledge Conferencel

Figure 7.4: You can use the Find dialog box to search the full text of any docu-
ments displayed in iManage View
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Note: The Find Text dialog box operates only on the active document displayed
in iManage View. That document must be a word-processing document or
spreadsheet. Textual searches cannot be performed on other document types.

1. Select Find from the Search menu.

2. Enter the text for which you want to search in the Search String field.

3. Ifyou click the down arrow i}, you can select from a list of search strings
that you entered previously.

4. Click OX to start searching.

Search Options

«  The Match Case option specifies whether the search should be case-sensi-
tive. If you do not check Match Case, all instances of your search siring will
be found regardless of whether they appear in upper or lower case.

«  The Origin options specify where the search should start. If From Cursor is 7
selected, the search will begin at the current position of the cursor in the
active document. If Entire Scope is selected, the search will begin at the
start of the document and proceed forward, or at the end of the document and
proceed backward, depending on which direction is selected.

»  The Find Backwards option specifies the direction the search should pro-
ceed.

Printing Documents

You can print all or portions of documents that are displayed in iManage View by

clicking on the Print icon or by selecting Print from the File menu. You may
also select Copy from the pop-up menu on a right-mouse-click. When you select
Print, a standard Prin? dialog box appears. The Print option operates on only the
currently active document in the iManage View window.

Setting Print Options

You can set printer options from the iManage View window by selecting Printer
Setup from the File pulldown menu. A standard Print Setup dialog box appears.
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Copying Documents

You can copy all or porticns of documents for pasting into other applications by
highlighting the portion of the document that you want to copy, then clicking the

Copy icon or selecting Copy from the Edit menu. You may also select Copy
from the pop-up menu on a right-mouse-click.

Setting Display Options

You can display documents in iManage View in a2 number of different formats.
Different documents can be displayed in different formats at the same time.

Word-Processing Documents

‘You can display word-processing documents in Draft, Normal, or Preview
mode: '

*  Draft mode displays the document using the default font without the origi-
nal formatting. Text wraps as necessary to display all text in the view win-
dow.

= Normal mode displays the document using the specified fonts in the docu-
ments and using the specified formatting. Text wraps inside the view win-
dow to display all text in the document.

= Preview mode displays the document using the specified fonts and specified
formatting. Text does not wrap in the view window: Preview mode shows
how the document would look when printed.

Bitmap Files

You can adjust the size of bitmap files that are displayed in the iManage View
program and/or rotate these images in the display by increments of 90°. To
change the size or rotation of a bitmap image, select the window in which the
image is displayed, then select Bitmap from the Options menu. A submenu of
display options appears. Select the size and/or rotation desired.

Vector Graphics

You can adjust the size of vector graphics files that are displayed in the iManage
View program by selecting Vector from the Options menu. A submenu of dis-
play options will be displayed. Select the option desired.

170
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Setting Default Display Options

You can select a default font that will be used to display ANSI text and select a
file format to use to view files of unknown type. To set these options, select
Options, Document, then Font. The Display Oprions dialog box will be dis-
played. The Display Options dialog box lets you specify iManage View’s default
fonts and file formats.

Display Options

Figure 7.5: Display Options dialog box

*  To change the defanlt font of ANSI files, click the Change button. A stan-
dard Windews Fonts dialog box appears, allowing you to specify the font.

*  To set the default display mode for documents of unknown file type, select
the corresponding display option.

*  To display additional options, click More. The More Display Options dialog
box appears.
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More Display Options

172

You can also set display options that specify how to display database tables and
spreadsheet information. If you want to show gridlines for either of these dis-
plays, check the Show gridlines options.

The More Display Options dialog box is displayed by clicking on the More but-
ton in the Display Options dialog box.

Note: The options included for specifying display options for archived docu-
ments are not implemented.

More Display Dptions

v o

Figure 7.6: More Display Options dialog box
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Overview

A portable mode of operation allows you take the iManage DeskSite document
management system on the road with you and helps you synchronize your work
with the network when you get back to the office. The process works like this:

1. A user checks out the desired iManage DeskSite documents, individually or
en masse.

2. Once disconnected from the network, you can access portable documents
through the iManage Portable application or through the standard commands
{open, save, etc.) of an integrated application.

3. 'When the user re-attaches to an iManage DeskSite database, you can auto-
matically check in the checked out documents and synchronize them with
iManage DeskSite. :

From Portable mode while disconnected from the network you can perform
the following standard iManage functions:

*  Import documents and assign a new document profile
*  View and Quickview documents
»  Save edited documents as new documents

*  Save edited documents as the same document, thereby replacing the network
version when synchronized with iManage DeskSite

»  Edit and View document profiles

»  Send documents as attachments to emails
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What you cannot do in Portable Mode:

+  Save document as a new version of the same document
«  Edit document security

Note: Echo documents are also accessed through portable mode. See Chapter 9:-
Using Echo Documents.
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Setup Procedures

Portable-mode operation does not require extraordinary amounts of memory or
resources on the portable PC and does not require a separate stand-alone SQL
database on the portable PC. '

To access portable documents effectively, yon need to set up your PC in the
following manner:

*  The PC must be registered for portable-mode operation.

*  The PC should be able to run from a local copy of the Windows operating
system.

= Local stand-alone versions of the application programs asscciated with the
portable documents should be available on the PC.

Application Setup in iManage Portable

The local application table contains information that is used by iManage Portable
to launch applications and to associate particular document types with appropri-
ate applications. It is recommended that you do NOT edit the local copy of the
application table UNLESS you understand the way applications are integrated
with iManage. Information on how the application table is created and main-
tained and how iManage is integrated with other applications is provided in the
iManage DeskSite Adminisirative Reference Manual,

Reasons why you might need to change the local copy of the application table
include:

»  The path to an application changes
= You want to associate a document type with a different application

+  You want to integrate an application that is not listed in the application table
on the database

To Add or Edit an entry to the local application table:

1. Click the App Setup icon | or select Local Applications from the

Options menu.
2. Click the Add or Edit button in the Application Setup Information dialog.
3. Complete the fields in the App Setup Entry dialog, Click OK when finished.
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Note: iManage Portable’s on-line help contains a detailed explanation of each
field appearing in the App Setup Eniry dialog.

Checking Out Portable Documents from iManage
DeskSite

176

iManage DeskSite provides you with the ability to check out multiple documents
in a single operation for portable-mode access. The checked-out documents are
marked as in use in iManage DeskSite.

The checkout process copies the documents to the portable-document location on
the local PC. This location is defined during portable-mode registration.

The profile information of the checked-out documents is also copied to the local
portable-document location. iManage Portable uses the local profile information
to find and access portable documents. You can change the profile information in
portable mode. '

To checkout a document in portable mode:

1. Select a document by clicking on it in the iManage Desktop window’s Docu-
mentt List. The document row becomes highlighted.

2. Click the Checkout toolbar button. The Checkour dialog box appears.
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Ehecknut -

B/21/01

Figure 8.1: Checkout dialog box

3. Place a checkmark in the Portable Checkout field. The Destination Path
field becomes deactivated because all portable documents are stored in the
same directory.

4. Note your reason for checking out the document in the Comments field,
specify the due date, and click OK. The iManage Desktop window reap-
pears.

Working with Portable Documents from within Integrated
Applications

You can open documents that are checked out in portable mode from within inte-
grated applications.

Steps:

1. Launch iManage Portable if it is not already running.
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2. Launch the integrated application

3. Select Open from the File menu in the integrated application. The Inte-
grated Portable Desktop dialog box appears.

- iPortable Database:
- BusDev i
d Corporate : . RevisedD...
Cotresponderic
-5 dbase?l

-5 Dev

in... Marketing ...
Proposals

2 Manage
Legal
Marketing

Figure 8.2: Integrated Portable Desktop dialog box

Working with Portable Documents from within iManage
Portable

You may access documents directly from the iManage Portable application. i

Read-only documents are indicated in the Portable directory by a locked icon@ .
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Figure 8.3: iManage Portable Application Desktop window

To Open Portable Documents

02429420001
© 0124292000 1
| 02126720001
020262000 1
‘02426620001

2000 3

027262000 1

1. Launch iManage Portable and select Checkedout Documents from the
drop down list. The Checkedout Documents list appears in the panel.

2. Select the desired document and click the Open ico

or just double-click

on the desired document. The document opens in the local application that is
associated with the document’s type.

Note: The Portable program looks for documents that were checked out by the
same user whose ID was used to log into Windows. If you checked out docu-
ments for portable use using a user ID other than the one you used to log into
Windows, the Portable program will not be able to find those documents. If that
happens, log out of Windows and log back in using the user ID that you used to
log into the WorkSite Middle Tier Server when you checked out those portable

documents.

To View Portable Documents

There are two options to view portable documents.
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To view a portable document using the iManage View program:

iManage View is a sophisticated viewer program allowing you to view multiple
documents at the same time and in different formats. To view a document this

way, highlight the desired document(s) and click the View icon |SF
View from either the Document menu or the right-click pop-up menu on the
selected docurnent.

To view a portable document using Quickview:

Cuickview is an easy way to view a document without leaving the Portable appli-
cation. To view a document this way, highlight the desired document and click

the Quickview icon =4 or select Quickview from either the Document menu
or the right-click pop-up menu on the selected document.

Editing/Viewing Portable Document Profiles

Portable document profile information can be accessed and edited by highlight-

ing a decument in the document list and clicking the Edit Profile icon or by
selecting Edit Profile from either the Document menu or the right-click pop
up menu of the highlighted document. Profile information can then be viewed
and updated. Updated profile information is verified when the portable docu-
ments are checked back into IManage DeskSite.

Printing Portable Documents

You can print documents directly from iManage Portable by clicking on the Print

icon [&]] or by selecting Print from either the Document menu or the right-
click pop-up menu on the highlighted document. This will avtomatically launch
the document in its associated application and perform a print command.

Note: This portable print command does not launch a Print Options dialog box
before printing. See the next section about Print and Page setup options.

Print and Page Setup Options

Select Printer Setup from the File menu to launch the Prinfer Setup dialog.
This dialog provides choices of printers, page types and Portrait/Landscape ori-
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entation formats.
E-mailing Portable Documents

From the iManage Portable application you can create a new e-mail message
with selected documents as attachments.

3. Select the document or documents you wish to attach and click the Send icon

r select Send from either the Document menu or the right-click pop-
up menu of the highlighted document. The Mail Documents window opens.

ail Documents

Figure 8.4: Mail Documents window

4. Ifthis is the document you want to send, click Mail. A new e-mail launches
automatically from your e-mail application with the selected documents as
attachments.

5. You can remove any document from the list by highlighting the document
and clicking Remove.

Import Documents to iManage Portable

If you have created a brand new document while away from the network you can
integrate it with iManage DeskSite when you return to connectivity. Do this with
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the Import feature.

Steps to Import:
1. Launch iManage Portable.

2. Click the Import icon or select Import from the File menu.

Dehex.di

_ - %] Demet.di
D bésdmin. GID Dess.dl

Dbadrin.hip  [%]Detrez.di
D8Admin.log %] Dewp.d

All Files *.*

Figure 8.5: Find File To Import dialog box

3. Usethe Find File To Import dialog to navigate to the document you want to
import. When highlighted, click Open.

4. The New Document Profile dialog launches. Complete the decument’s pro-
file and click OK when complete.

The document then appears in the document list of iManage Portable. Tt is ready
to be checked in with all the other documents when vou re-connect to the net-
work.

Check-in Portable Documents

182

When you have been working in portable mode and you attach to an iManage
DeskSite database, you can check in the checked out documents and synchronize
them with iManage DeskSite. The check-in process verifies the profiles of the
portable documents against the profile-entry tables. If errors are detected, you are
prompted to enter correct information.
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To check-in a portable document:

1.

Launch iManage DeskSite and click Checkin on the toolbar. The
Documents dialog box appears.

Checkin

Select the documents to be checked in using standard Windows techniques.

Click the Checkin button. The Checkin Options window appears.

Select either the Replace Original or New Version option. To apply the
selected option to the entire group of documents that you’re checking in,

select Apply to All

Click OK to check in the documents - and return to the Checkin Documents

dialog box.
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Overview

All computer networks fail at some point. iManage has created a safeguard for
such an event. It’s called document echoing.

Every time you close an iManage documnent, iManage DeskSite saves a duplicate
copy to your hard disk. This is done to ensure that you can still access and per-
form functions to your important and recently used files, even when the network
fails.

If you make revisions to these documents offline, iManage DeskSite provides a
synchronize function to integrate revised echo documents back into the network.
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Setup

Enabling Document Echoing

iManage DeskSite echoes documents en your PC only if Document Echoing is
enabled.

Your iManage DeskSite administrator can disable document echoing globally or
for any given class of documents. If your PC is registered for portable mode but
iManage DeskSite is not echoing documents to your hard drive, comtact your sys-
tem administrator for more information.

If you are enabling document echoing as a safeguard against network failure, you
should also ensure that your PC is able to run a local copy of the Windows oper-
ating system and local, stand-alone versions of the application programs associ-
ated with your echoed documents. In the case of a network failure, networked
copies of Windows and of essential application programs are not available.

Even in the absence of the application programs associated with your echoed
documents, if you have a local copy of the Windows operating system on your
PC, you can view your echoed documents using iManage View.

Setting the Default Drive for Echo Documents

You can select the disk drive where iManage DeskSite saves echo docurments.
Normally, the echo documents are stored on a disk drive on the user’s local PC.
While the disk drive for the echo directory can be changed, the name of the direc-
tory is always nrtecho.

1. Choose Options from the Options menu to open the iManage Desktop
window’s Configure dialog.
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hitp:¢ Awarksite.manage.com

Figure 9.1: Display Options dialog where Echo defaults are set.

2. Specify the disk drive where iManage should store your echoed documents
and the maximum size of the echo directory. If the total size of the echo
directory exceeds the specified limit, iManage DeskSite prompts you to
purge the echo directory. For instructions on how to purge echoed files from
the echo directory, see “Purging Fcho Documents™ on page 196. You can
change the size of the echo directory, if you need to, by clicking the up or
down arrows in the Echo Size (MB) field.
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Using Echo Documents

Access

188

You can access echo documents either through the iManage Portable application
or through an integrated application such as MS-Word, WordPerfect, etc.

Note: If you attempt to open a document that is currently in your Echo directory
because you worked on it previously and made changes to it that are not reflected
in the copy on the file server, iManage DeskSite will not let you open the docu-
ment. Since iManage DeskSite copies a document to your Echo directory when
vou open it, this feature prevents you from overwriting changes that you made to
the document.

Echo Documents from an Integrated Application

Steps to open documents that are checked out in portable mode from within inte-
grated applications:

1. Launch iManage Portable if it is not already running.

2. Launch the integrated application.
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Figure 9.2: Integrated Portable Desktop

Access Echo Documents from the iManage Portable
Application

Launching iManage Portable allows you to perform a variety of finctions with '
echo documents. The main desktop screen looks like this:
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Figure 9.3: iManage Portable Desktop Window
Functions within iManage Portable

Because both Echo Documents and Portable documenits are accessed through
same Portable application the document functions are identical. Chapter 8 con-
tains greater detail of the following document commands:

Open Echo Documents

Double-click on the desired document in the Echo Document List or highlight

the document and click the Open icon You then get a message that the doc-
ument may have been changed by another user. If this is the case, you can check
in the document to iManage DeskSite only as a new document.

Your system administrator may have configured your machine to display echo
documents for ail users on your machine,
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Figunre 9.3: Echo document warning message

View Echo Documents:

Highlight the document(s) and click the View icon This will launch iMan-
age View - a sophisticated viewer application. See Chaptet 7 for more informa-
tion.

Quickview Echo Documents

Highlight the desired document and click the Quickview icon . The document
will be displayed in the bottom right frame of the Portable Desktop Window.

Printing Echo Documents

Highlight the desired document(s) and click the Print icon [&#]. The document’s
associated application will launch and the document will be printed. Please note
that this portable print command will not launch a Print Options dialog box
before printing. See the next section about Print and Page setup options.

Printing a List of Echo Documents

To print a list of the documents currently displayed in the Document List of the
Portable Desktop select Print Preview from the File menu. This will launch the
list in the Print Preview dialog where you can execute a print command.

Sending Echo Documents

Highlight the desired document(s) and click the Send icon . A new e-mail
will launch automatically with the selected documents as attachments.
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Saving Echo Documents

After opening an echo document, you can save changes or revisions to it with the
Save command under the File menu in the application associated with that docu-
ment. Documents saved using the save command will be recognized in iManage
DeskSite as echo documents. If you use the Save As command to creats a new
document from a revised echo document, however, the document will be identi-
fied as a new portable document in iManage DeskSite.

Deleting Echo Documents

Highlight the desired document(sy and click the Delete icon . You can also
delete Echo documents from the Checlin/Synchronize dialog box in iManage
DeskSite.

Editing and Saving Echo Documents

After opening an echo document, you can save changes or revisions to it with the
Save command under the File menu in the application associated with that doc-
ument. Documents saved using the save command are recognized in iManage
DeskSite as echo documents. If you use the Save As command to create a new
document from a revised echo document, however, the document is identified as
a new portable document in iManage DeskSite.

Synchronizing Echo Documents into the Network

If you edit and save an echo document while offline, you will eventually want to
copy the document back to the network after network connections are restored.
iManage DeskSite provides an easy way to copy echo documents that have been
revised and saved locally back to the network. This process of copying altered
echo documents back to the network is referred to as synchronization

When you start iManage DeskSite you will get a warning if you have echo docu-
ments with changes that are not reflected in the copy on the file server. This fea-
ture helps prevent you from overwriting changes that you made to the document.

Requirements for synchronization of a document

*  Only the last user who edited a document through iManage DeskSite may
synchronize an echo document. Other users who attempt to do so receive a
waming message and are instructed to contact the particular user who last
edited that document.
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»  Your echo copy of a document must be newer than the copy on the network.
iManage DeskSite does not allow you to synchronize an echo document
back to the network if the network copy of the document is newer than your
echo copy.

*  You must have wrife access to the network copy of the document. You can-
not synchronize a document if you have read-only access to the document.

You have the option of copying a document back as the original document,
importing it as a new version of the original document, or importing it as a new
document. If you are unable to use iManage DeskSite’s synchronization process
to copy your updated echo document to the network, you can instead import the
echo document as a new document or a new version of the same document.

To synchronize an echo document:

1. In iManage DeskSite open the Checkin/Synchronize Documents dialog by
selecting Checkin/Synchronize from the Portable menu.

Finance Dorumentation Lpd.
{Z Finance aimdf70520011910...
151 Finance Project Plan

{[E] Firance Fievised Documents
i Finance M arketing O ptions

Figure 9.4: Synchronize/Purge Echo Documents dialog box

2. Profile information for echoed documents appears in the display table. Use
the horizontal scroll bar to display more profile fields.

AUTED20193



iManage DeskSite User Reference Manual

*  Use the vertical scroll bar or Page Up and Page Down buttons to dis- |
play all the echo documents. |

+  Use the Find button to search for echoed document profiles if the list is
large.

«  Check Show only echo modified to display only the echo documents
that have been changed.

3. Use standard Windows techniques in addition to the Select All and Deselect
buttons to select documents for synchronization back into the iManage
DeskSite database.

4.  Click Synch to begin the synchronization process. The Confirm Synchronize
dialog box opens.

\ onfirm Synchronize

Figure 9.5: Confirm Synchronize dialog box

5. Verify the comparison between the Echo document and the Database docu-
ment. Choose whether you want to replace the original document, create a
new version of the docurnent, or create an entirely new document. Not all of :
these options are available in every circumstance.

+  Tfthe document is checked out in the iManage library, you can retutn
the Echo document to the library only as a new document.

191 AUT0020194



Chapter 9: Using Echo Documents

Orphan

«  lithe document is nof checked out in the iManage library and you were
the last user of the document, you can return the Echo document to the
library as a new version, a new document, or replace the original docu-
ment.

+  Ifthe document is not checked out in the iManage library and you were
riof the last nser of the document, you can return the Echo document to
the library only as a new version of the document or as a new document.

6. Click OK to synchronize the document, Cancel to cancel the synchronize
operation for all documents you have highlighted, or Skip to cancel the syn-
chronize operation for the specified document only.

Icons in the Checkin/Synchronize Documents dialeg box

Icons in the Checkir/Svnchronize Documents dialog indicate the condition of the
documents displayed in the windows. The list explains what the icons mean:

= — This icon appears in the document display area of Checkedout Docu-
ments tab. The document that it is associated with is a checkedout docu-
ment.

— This icon appears in the document display area of both the Checked-

out Documents and Echo documents tab. [n the Checkedout Documents
tab, this icon indicates that an “orphan” document exists in the NiPortbl
directory. In the Echo Documents tab, this icon is used to indicate
unmodified echo documents that exist in the NrtEcho directory.

E: - This icon appears in the document display area of Echo Documents
tab. This icon identifies echo documents that have been modified and
need to be synchronized.

Documents

A user may have documents in his or her Portable or Echo directory which are
not checked-out by that user (Orphan documents). When the user starts working
in Portable mode, iManage DeskSite shows that the document is checked-out.
The user can modify the document in Portable mode. However, when the user
starts iManage DeskSite, he or she needs to know the local copy of the document
has modifications that are not in the iManage file server copy.

iManage DeskSite identifies documents in the user’s NRPortbl or NRTEcho
directory and determines if they are checked out by the user. If there are docu-
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ments in the NRPortbl or NRTEcho directory that are NOT checked out by the
user, iManage DeskSite distinguishes those documents from documents checked
out by the user or created in Portable mode that need to be checked in.

You can then import the orphaned documents into iManage DeskSite as new doc-
uments.

Purging Echo Documents

1. IniManage DeskSite, open the Checkin/Synchronize dialog by selecting
Checkin/Synchronize from the Portable menu.

2. Click Purge. The Set Purge Criteria dialog box appears:

Set Purge Criteria

Figure 9.6: Sef Purge Criteria dialog box

3. To delete all documents older a cerfain number of days, enter the maximum
age in days of echo documents that you want to keep and click the OX but-
ton. All documents older than the specified mumber of days are deleted.

Note: The number of days set in the Set Purge Criteria dialog box is only for
this manual puige of the directory. Echo documents continue to accumulate
unless you purge the directory in this manner agaiﬁ. For mstructions on how to
purge the echo directory automatically, see the iManage DeskSite User Reference
Manual. '

Purging Echo Documents Automatically

You can set up your comprter to automatically delete echo documents based on
age at startup of iManage Portable. To implement this feature:
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1. Create a shortcut to Portbl32. exe
2. Right-click on the shortcut and select Properties.

3. Inthe Properties dialog that appears, click the Shortcut tab.

Marmal window

Figure 9.7: Shortcut Properties dialog box

4. Inthe Target field, enter the path to the portable executable file followed by -
D then the maximum age of echo documents in days.

5. Example: If iManage is insialled in the default installation path, yeu might
enter the following in the Target field:

"C:\Program Files\iManage\Porthl32.exe" -D 20

Where 20 represents the maximum age of an echo document in days. Docu-
ments older than this specified number of days will be deleted.
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6. When you double click oﬁ this shorteut to run the Portable application, any
echo documents elder than the specified maximum age are deleted.

Silent Mode

You can also use this command line feature in silent mode. Silent mode means
that when you double click on the shortcut, the Portable application only runs
long enough to delete any echo documents older than the specified maximum
age, then exit. To implement this feature in silent mode, substitute -DS for -D.

Example: "C:\Program Files\iManageiPortbl32.exe" -DS 20

This command line opens iManage Portable, purges echo documents older than
20 days from the echo directory, then exits from iManage Portable.

Figure 9.8: Shortcut Properties silent mode dialog box
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Purging Documents for All Users

You can use this command line to purge echo documents for all users, not just the
current user. To do this, substitute -PS for -D or -DS.

Example: "C:\Program Files\iManage\Portbi32.exe" -PS20

This command line opens iManage Portable, purges echo documents older than
20 days from the echo directory, then exits from iManage Portable.

‘C:\Program Files\ikd anage"

Figure 9.9: Shortcut Properties silent mode dialog box to purge echo documents
for all users
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